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1 Introduction

This user guide explains how to use Beckhoff TwinCAT NCI or CNC in conjunction with Triamec EtherCAT
drives. EtherCAT drives from Triamec are marked with the letter “E” after the name, i.e., TSD8OE, TS-
D85E, TSD130E, TSD350E, TS360E, TS710E.

The TriaLink series TS35x, TSP700, TSD8OT etc. are not covered with this guide. See (*) on how to set up
these drives with TwinCAT.

2 Configuring the drives

Before a drive can be used with TwinCAT, the drive has to be configured with the TAM System Explorer.
See the Setup Guide! for how to setup the drive parameter, install new firmware and for how to save
the parameters persistently on the drive.

Remarks:

= For configuration the drive has to be connected with the PC through a USB or Ethernet connection
and the TAM System Explorer has to be installed on the connected PC. It is recommended to set
“File > Preferences > Startup > Acquired Adapters” to “Triamec devices over USB” or “Triamec De-
vices over Ethernet” to accelerate booting. The EtherCAT control system PC does not require an in-
stallation of the TAM System Explorer if it is not intended to used for configuration or debugging of
the drive.

= When using the TAM System Explorer to configure the drive, the drive must not follow the EtherCAT
commands. Therefore set Axes[].Commands.General.OverwriteControlSystem to 1 or, when using
the Axis Module, use the button “Attach” to set the OverwriteControlSystem command. Don't forget
to reset the command when the configuration is done.

= Set Parameters.PositionController.PositionUnit for each axis for proper position scaling as discussed
in chapter 6.1.

= To not loose the settings on a power-down of the dive save the configuration persistent on the drive
as described in . Later changes of the configuration need to be persisted again to not be lost after
a power-down. Also save the configuration as a *. TAMcfg file on the PC.

1 SWTC_TwinCAT-UserGuide_EP*** pdf in Help > Documentation/Software.
2 SW_TSD-TSP360-TSP710-Setup-Guide_EP*** pdf in Help > Documentation/Software
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3 Preparation of TwinCAT and DC

Copy the device description file (ESI) “Triamec.xml” to “C:\TwinCAT\3.1\Config\lo\EtherCAT". If TwinCAT
was already open, choose “Twincat/EtherCAT Devices/Reload Device Descriptions”.

Open a new Twincat Project and add an Ethercat Adapter.

= |O/Devices/Add new item
= Ethercat/Ethercat Master

If there is no EtherCAT driver installed yet, try the menu “TwinCAT/Show Realtime Ethernet Compatible
Devices” in the TwinCAT environment. Make sure the LLDP Protocol is disabled (?).

Make sure the cycle time of Distributed Clock (DC) Sync is a multiple of 100us. Choose for example

= System/RealTime/Settings/BaseTime 200us
= For NCI: Choose MOTION/NC-Task1 SAF/Task/CycleTicks=2 400us (must be n* 100us)
= For CNC: Choose MOTION/CNC Task GEO/Task/Cycle Time=2 400pus (must be n* 100us)

Consider the sync shift settings at EtherCAT/EtherCAT/AdvancedSettings/DistributedClock/ SyncShift-
Time if the jitter on the host PC is large.

Set Drive/EtherCAT/AdvancedSettings/DistributedClock/”UseAsPotentialReferenceClock”

4 Drive setup in TwinCAT

On the EtherCAT master, choose “Add New Item” and choose “Triamec Motion AG/Drives/TriamecDu-
alDrive”. You will be asked, if new NCI-Axes should be added. Answer

=)

General | EtherCAT | DC Process Data | Slots | Startup | CoE - Online | Online
j Solution ‘TriamecEcatCnc' (1 project)

= yes, if you intend to use NCI

. . <& TriamecEcalCne Siot Module Des...
= no, if you intend to use CNC ' @Jﬂgﬁg’; @ uis0 @ b0 W32 2
) i pLc Btd Module 1 (csp - ads) @ 10wt 2anfloat32 float32
oy . ©Ed & fods 1
If you need additional cyclic data i SAFETY -
y ) y : ’ C++ .EHMouleZI_csp axis)
open Slots in the Ethercat drive. Use . Ziwo o
the left arrow to add your choice. ‘ :%E_f"'[,‘;ﬁm(ahe,m @ Etersirs
+8 Image
Choose to S8 | oge-Info
A . 2 SyncUnits
= Change the axis from default to - Tputs
. . [ Outputs
touchProbe, if you want to use @ InfoData
. a Drive 2 (Triamec
the TwinCAT touchProbe feature. Cl—
. . a Inputs < LI} r
= QOpen the first extension and se- ;sttatuswmd
. . A ActualPosition Download SlotChg (=P} | Create Project Specific XML File
lect one choice from the right list 2 pestontrer ¢
for integer or float variables. ;r Actualveloctty . § Name Online Type Size  >Adds
orqu Ctua
. ! Status Word X 1085 UINT 20 1.0
Check AN104 on how to use this “ -;:Iti:irulwurd 1 ActualPostion X 363399195 DINT w750
feature . - TargetPosition d L C

3 NetworkConnections/Properties/MicrosoftLLDPProtocolDriver is disabled.
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4.1 Using the NCI

If you answered “yes” in the “Add new item” dialog above, a new NCI axis was added for every axis in
the drive and connections were made between the drive and the NCI. Consider

= NciAxis.Parameter.Dynamics: Set the dynamic Parameters
= NciAxis.Parameter.OtherSettings.CoupleSlaveToActualValueslfNotEnabled TRUE

Choose Twincat/ActivateConfiguration to run Twincat.

Then the NCl interface should look like

o Iriamec_nci.tsm - TwinCAT System Manager

Datei Bearbeiten Akbionen Ansicht  Optionen  Hilfe

Dewd &R AR &) L ELC ISR
£, TCOM Objects ~ _ .
BB e - Kanfiguration Funklionen Kopplung Kampensation _
= - MC - Konfiguration Allgemein Einstellungen Parameter Dynarmik, Oriline
=B MC-Task 1 SAF e
MZ-Task 1 SVEB \ 51 6980 Soll-Pozition: = B[g:gna]
=f= MC-Task 1-Prozessabb g i i ;
7] Tables 5 chleppabstand [min/max] [mm] Sol-Geschwindigk.: [rmmds]
=M Achsen 00000 [-1.232,1.231) 0.0000
= e Achse 1 Qverride: [%] Gesamt-/Realerausqgabe: [%] Fehler
=4, achse 1 Enc 1000000 % 0oo/ 000z 0(0=0)
Ll Eingé_l_'uge Statuz [log.) Statuz [phys.] Freigaben
g ;lhjeuiggl:iz Bereit _ F{Eihrt NI_I;HT | Gek.cuppel_t. Fegler
= [JReferenziett  [] Fahit griofer [J1n Zielposition Yaorschub +

%T Eingange
$!| susganoge
T, Achse 1_Chrl

[THat sufrag [ ] Fahit kleiner []In Pos.Bereich Warschub -

%T Eingénge F-:egler Kow-Faktar: [mm!s:’mrln.] Ezezznungx-ﬁesu:hwmdlgkat: [mmf]
‘.I, Ausgange J J
i fchse 2 Zielpozition: [mm] Ziel-Geschwindigkeit: [mmé's]

i} Achse 3 0 J 0

=5 5Ps - Konfiguration

1
=L Triamec_nci
- _ria ink-Prozessa —- iy + ++ @ e
a;ﬁﬁ'yip " F1 | F2 | F3| F4 |- - FB| F9|

& - W
F .

First, enable is off (Freigaben are not selected). You can move the axis by hand and see the actual posi-
tion reflect the correct position. If the actual position is gray, the axis state is not valid. Make sure the
drive is in the EtherCAT operational state (see drive Online) and the drive is not in an error state (see
cyclic signal “error” or the COE-online objects 0x6035 (axis 0) and 0x683F (axis 1).

Now enable the axis using Freigaben and Regler, Vorschub+, Vorschub-, Override 100%.

Press + and - to move the axis. The axis should move and the actual position should change accordingly.
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4.2 Using the CNC

Attach the CNC using “Add new Item” on the MOTION node.
Attach an axis using “Add new item” on the MOTION/CNC-Task GEO/Axes node.

Select the Triamec Axis using “Link To” and make sure FeedAxis is selected.

I,ja Selution ‘TriamecEcatCnc' (1 project)
4 ﬂ TriamecEcatCnc
S I
<[ voron
[y NC-Task1 SAF
4 CNC-Task GEO
» [B1 CNC-Task SDA
p o [B1 CNC-Task COM
5 Image
Inputs

General | Configuration | E
I I Drive 2 (Triamec) # A

I Input I Output I Online|

Huis Type: [C.»‘\Nopen D5402/Profile MDP 742 (e.g. EtherCAT CoE Drive)
Spindle [}
Default Channel: [Channel_‘l

Defautt Name: X Default Index: 0

Feed Axis

W Outputs
4 T fues

e

[Add//Delete Compensation Table

Attach a channel (Kanal) using “Add new item” on the MOTION/CNC-Task GEO node.
Choose Twincat/ActivateConfiguration to run TwinCAT.

The axes will not be enabled yet. Each axis can be moved by hand and the ActualPosition should change
correctly in the CNC window.

=N ol >
L ® [ |EQRE T e D ?

— | | Algemein | SDA Para | NP Para | PZV Para | VE Var | Online | =

! Triamec_cnc.tsm - TwinCAT System Manager
Datei Bearbeiten Aktionen Ansicht Optionen  Hilfe

el &R ¢ hﬁﬁlﬁ 8| = as
- - Bl SYSTEM - Konfiguration
=88 CNC - Konfiguration
2-[B1 CNC-Task GEO

»

CNC-Task SDA Marne Altuelle Gesch... | Soll-Geschw. | COverride | Set Mo. | -
-[B -Tasl
G [B1 CNC-Task COM Kanal 1 0.0 0.0 1000 | (keine) S
=4 CNC-Task GEO-Prozessab
_____ 1 Eingange Marne Ist-Pos. | Schleppab. |Target Pos. |Aktuelle Gesch... | Status |
..... $| Ausginge X (Achse 1) 405.2654 0.0000 405.2654 0.0 Ready |
E—]:a Achsen A Y (Achse_2) 0.0000 0.0000 0.0000 0.0 Ready 1
G-Smk Achse 1 1 7 (Achse 3) 0.0000 0.0000 0.0000 0.0 Hold
(-l Achse 2
H AChSE_a _
+-Bm Achse C
2t Kanal_1

..J8l NC - Konfiguration
158 SPS - Konfiguration
= EfA - Kenfiguration
ﬂ E/A Gerdte b

i [ Einzelschritt Standby / Selected (Interp Empty)

=R Zuordnungen i
g —— | : [CBlock lgnore [ Manwell | [ Automatisch | | MDI ] i
Server (Port) Tirmestamp Meldung

L]

@ TwinCAT Sys.. 28032014 16:31:25625 ms  TwinCAT Systern Restart initiated from AmsMetld: 192,168.10.81.1.1 port 32902,

Bereit Lokal (192.168.10.81.1.1) Qd)iei@leia

Enabling the axes requires an HLI command to the CNC. An example PLC program is available in the
Sample code.

Open the CNC channel control window: CNC-Task GEO/Kanal_1/Online.
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Switch to Operation mode “Manual”. Select the first axis. Press + and - to move the axis. The axis should

move and the actual position should change accordingly. The position “DistanceToGo” should reach
zero at standstill.

Configure

= the CNC channel in CNC-Konfiguration/CNC-Task GEO/Kanal_1 and
= the CNC axes in CNC-Konfiguration/CNC-Task GEO/Achsen/Achse_n/Parameter

as shown in the CNC-documentation.

5 Identification

Triamec drives support the EtherCAT “Explicit Device Identification” method (FW>=4.4.0). This requires

the ESI-File Triamec1.4.xml. Setup the address in the drive register General/Parameters/LinkAddress
and make the parameter persistent (chapter 2).

Setup the address as “Identification Value” in the TwinCAT EtherCAT section of the drive (see figure be-
low). If this value is not changeable, the ESI-File version might be smaller than 1.4. Then open the ad-
vanced Settings dialog and select General/Behavior/Checkldentification.

Advanced Settings

General EtherCAT  DC Process Data Slots  Startup CoE-Online  Online ;G”E’ﬂ Behavior

; ; Startup Checkin:
Type: |Triamec DualDrive | Timeout Settings P 9
|dentification []Check Vendor Id
Product/Revision: | 363 /1 | FIMU / SM Check Product Code

Init Commands

Auto Inc Addr: FFFD

[ Check Revision Number

v Mailbox
EtherCAT Addr: Advanced Settings... 11 Distributed Clock
. ESC Access Check Seral Number
Identification Valug [#] Check Identification
Previous Port: l ecUualDrive) - B
Process Data

[ Use RD/AWR instead of RW

Then specify “Explicit Device Identification” in the same dialog under General/ldentification.

Advanced Settings

=) General Identification
i i Behavior
Timeout Settings Identification ADO
iericaton ONere
FMMU /7 5M (7) Configured Station Alias (ADO [x0012)
: -Init Commands - )
. (®) Explicit Device |dentification (ADD (x0134)
+- Mailbox

4. Distributed Clock () Data Word (2 Bytes)

- ESC Access
Value: 18 =
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6 Positions

6.1 Choose position scaling

EtherCAT uses integer32 for positions whereas Triamec drives use the double format representing SI
units (double meter or rad or similar). Therefore the drives need to convert the double to integer.

The standard scale factor of EtherCAT is 10'000 inc/mm or 10'000 inc/degree. Since the conversion fac-
tor depends on the axis type (linear or rotative), the drives need to know their axis unit. Specify the axis
unit using Parameters.PositionController.PositionUnits in the drive axis configuration.

To change the default scaling, use the startup parameter Feed (0x6092.01) for the first axis and
0x6892.01 for the second axis. Its units are inc/mm or inc/degree. It is part of the startup parameter list
as shown below. The standard is 10'000. To get for example 1nm resolution, choose the value 1000'000.
Be aware that this reduces the maximum possible position to 2**1nm = 2.1m.

=

X X X General | FtherCAT | DC Process Data | Slots [| Startup |CoE - Onling | Online
g Solution 'TriamecEcatCnc' (1 project)

4 :J TriamecEcatCne Transition  Protocol Index Data Edit CANopen Startup Entry
i @“‘ aréTﬂEng C <PS>  CoE BICI200 (00 (0) Trarshion
i pLc C<PS>  CoE B<IC13:00 (00 (0) |5 E ——— w0
S CArETy C <PS>  CoE BACI201 601 (5633) Cancel
C «PS= CoE Ox1C12:02 <1611 (5649) P25 S>P Sub-ndes [dec): 1
Cos C <PS:  CoE ICIZ00  x02(2)
4 EVo C <S>  CoE BICIZ0  BcIADT (B657) |50 g2e Validate Complete Access
4 “f Devices C<PS:  CoE IIC1302  1AT1 (66T ——
4 = Devicel (EtherCAT) C PS>  CoE WICI300 D202 Dhtallb=roER 0100 00 00 [ HexEdi. |
%9 Image @ 50 CoE es060:00 08 (8)
*+8 Image-Info @ so CoE B6092:01 | (00000001 (1) —
2 SyncUnits @ so CoE 026000 | BOB () Eomment ek
Inputs W so CoE 0<6892:01 | (x00000001 (1)
. [l Outputs Index MName Flags Walue =~
Erinfebet 1000 Device type M RO M0 383 (51
a B) Drive 2 (Triamec) 1001 Errar register RO 000 (0]
= ::: iriereeiiefpilic) 1008 Device name RO Triamec

This changes the scale at the interface. The TwinCAT path planner modules must also know this scaling
factor:

CNC
If a CNC is attached adapt the CNC axis parameter (see figure below)
getriebe[0].wegaufz 1 P-AXIS-00234 : Path resolution of the measuring system (num).

The unit of this parameter is 10'000 inc/mm or inc/degree. Its default is 1. Use this equation for the val-
ues of the drive and CNC parameters

0x6092.01 = wegaufz * 10'000

SWTC_TwinCAT-UserGuideEcat_EP007 2019-09-23 7/16
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o ) . General | Corfigurstich | Parameter | iput | Output | Online
olutien TriamecEcatCnc' (1 project)

a TriamecEcatCne Name Value
| SYSTEM —_—
=] MOTION -
a [[E CNC-Task GEO - . o
CUETUNCTTEER S DA ; - -
. [E1 CNC-Task COM e
28 Image ”
Inputs kopf achs_nr 1
B Outputs kopf mds_idert
4 Shules kopf log_achs_name Puiz_1
a |l Axis 1 artr.addroffs input 0
= pats artr.addroffs.output 0
1 WeState antr.canopen.in[0].signal_nr 0
&1 Status Word antr.canopen in[l] signal_len 2
&1 ActualPosition antr.canopen.in[0].nc_nef WCSTATE
#1 PositionError antr.canopen.in[1].signal_nr 0
# ActualVelocity antr.canopen.in!'!!.signal-_len %_" L
1 TorqueActual —
4 [ Outputs | Import... | | Export... | | Motepad... | |_
v Control Word | Download... | | Upload... | Comment

G TaraetPosition

NCI

Another use case is NCI. Lets assume a finer resolution of 1nm.

= Set the scale of the EtherCAT positions to 1'000'000 using 0x6092.01 as shown above.

= Set NC/Achsen/Achse_N/Achse_N_Enc/Parameter/ScalingFactorNumerator to 1E-6.
Select the row and use “Download, Save” to save the settings.
Reload the solution to activate the changes

6.2 CSP mode

The standard mode of operation is CSP, where commanded positions are expected cyclically. There are
three interpolation modes, specified with the drive register Axes[].Parameters.PathPlanner.StreamIinter-
polatorMode.

= Polynom3A A 3th order recursive polynom into the last three positions
= Polynom4A A 4th order polynom exactly fitting into the last five positions (legacy)
= BSpline3A A cubic B-Spline of the last three positions

Choose Polynom3A in standard situations with a smooth target path. Choose BSpline3A in situations
with not physical target positions.

6.3 Modulo

If the Triamec parameters Axes[]/Parameters/PathPlanner/ModuloPositionMaximum and ..Minimum
are unequal to 0.0, the axis runs in modulo mode. In CSP mode, it expects commanded positions within
this range. The actual positions from the encoders will wrap as soon as the respective commanded po-
sitions wrap.

The commanded velocity is not considered directly for path generation in CSP mode. However, it is con-
sidered at higher speeds to decide, what modulo wrap should be taken (FW 4.5.0). If, for example, the
NC-rate is 1ms and the target speed is larger than 30’000 turns/min, the drive will face more than half a

SWTC_TwinCAT-UserGuideEcat_EP007 2019-09-23 8/16



)

triamec

modulo per position update and it cannot resolve correct positions, if velocities are not provided. If the
velocity is correctly provided, the drive will decide for the correct modulo wrap in this case. See CSV
mode for the required velocity scaling.

Drive

Set the modulo ranges (if PositionUnits is on radian).

= Axis.Parameters.PathPlanner.ModuloPositionMaximum 2*pi
= Axis.Parameters.PathPlanner.ModuloPositionMinimum 0.0

CNC
If the axis is rotational with the CNC in units of 0.0001° and should get a 360° Modulo, set:

= kenngr.achs_typ 2 (ROTATOR) or 4 (SPINDLE)

= kenngr.achs_mode 0x4 (Modulo) +
= getriebe[i].moduloo 3600'000
= getriebe[i].modulou 0

» antr.drive_encoder_range 3600000. *
= if antrmode_act_pos or antr.mode_cmd_pos are defined, set these parameters to 2.

For details on CNC axis, spindle, and channel settings see the Beckhoff or CNC documentation.
NCI

See Beckhoff documentation on using Modulo Moves. Set NCI/Axis/Enc/Parameters

= ScalingFactorNumerator = 0.0001

= ScalingFactorDenominator = 1.0

= Modulo Factor = 360

= EncderMask = Ox36EE80 (3600000)

= EncderSubMask = 0x36EE80 (3600000)

= ReferenceSystem = Absolute(modulo)

= See Beckhoff documentation on using Modul

and in NC/Axis/Drive/Parameters
= QutputScalingFactor (Velocity) to 429.5 = (2232) / (1077)
and set Axis/Settings/Unit=Degree and activate Axis/Settings/modulo.

6.4 CSV mode

The standard mode of operation is CSP Mode (8), where cyclic positions are commanded at the inter-
face. With FW Release 4.5.0 CSV mode (9) is supported too, where cyclic velocities are commanded.

The resolution of the velocities are scaled by the same factor as for CSP mode: If for a rotational axis

= the feed object 0x6092.01 is 10000 inc/degree,

4 This value has to be scaled with getriebel[..].wegaufz/getriebe|..].wegaufn.
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= 3 position of 10000 inc  will correspond to 1 degree and
= avelocity of 10000 inc  will correspond to 1 degree/s

The drive side interpolation uses cubic B-splines in the target velocity and integrates these to a 4™ order
polynom in the position. To facilitate switching back from CSV mode to CSP mode, the signal General/
Signals/EtherCAT/targetPositionError is provided, which is the deviation between expected position and
commanded position.

6.5 Referencing (Homing)
With FW Release 0.8.9 (FW2086), we support three modes.

Absolute encoders return the correct position without a reference move. See AN107 for setup. With
Twincat-CNC pathplanner, make sure to set the kenngr.set refpos_mode to “OFFSET” and
kenngr.set_refpos_offset to 0 to avoid any difference between CNC and drive positions.

Drive controlled homing is described in AN107. See TwinCAT sample code for using this mode.

Reference moves controlled by TwinCAT are used to determine the position difference between drive
position and TwinCAT position. This is then taken into account by adding an offset between the inter-
face data and the display data. The drive positions are not referenced in this case.

7 Control and Status Word

Supported modes of operation modes for firmware 4.5.0 are PP(1), PV(3), HM(6), CSP(8), CSV(9). The
EtherCAT control word depends on the mode of operation.

Bit Register

0 SwitchOn

1 EnableVoltage

2 QuickStop

3 EnableOperation For modes of operation CSP, CSV
PP [4] NewSetpoint

PV [4] newSetpoint

HM [4] start homing

PP [5] ChangeSetimmediately
CSP [5..6] OutputCycleCounter
PP [6] relativeTargetValue

7 FaultReset

PP [8] halt

PV [8] halt

HM [8] halt

CSP [8] no function

CSV [8] no function

PP [9] changeOnSetPoint

SWTC_TwinCAT-UserGuideEcat_EP007 2019-09-23 10/16
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The EtherCAT status word

Bit Register

0 ReadyToSwitchOn

1 SwitchedOn

2 OperationEnabled

3 fault

5 quick stop 1 = quick stop is not active

6 switchOnDisabled

7 warning

8 follow me manufacturer specific

[10] PP+PV TargetReached / velocitylsZero if halt=0 /1

[10] HM TargetReached / velocitylsZero if halt=0/1

[10] CSP ToggleStatus not implemented

[10] CSV Toggle status not implemented

[11] internal limit is active

[12] PP+PV SetPointAcknowledge previous setpoint still in process
[12] HM Homing done

[12] CSP DriveFollowsTheCommandValue [12] Kap 6.2 of ETG6010_V1i1i0
[12] CSV DriveFollowsTheCommandValue [12] Kap 6.2 of ETG6010_V1i1i0
[13] PP+PV FollowingError

[13] HM Homing error

[13] CSP ExtendedToggle

[15] referenceDone manufacturer specific

A typical start sequence for the mode of operation 8=CSP is

status control
0x121 0 ReadyToSwitchOn

2 EnableVoltage
0x121 ReadyToSwitchOn

3 EnableVoltage+SwitchOn
0x127 Enabled

0xB EnableOperation
0x1027 CoupledMotion

Please note the following behaviour of Target position versus actual position in this sequence: As long
as bit 0x100=followMe is set, the drive actual position does not follow the target position. Instead, the
control system is expected to track the actual position by setting target=actual.

During the enabling phase, the actual position may be changing due to the axis phasing procedure until
the drive sets bits 1+2 (state=0x127) to indicate, it is enabled. Now the control system sets the com-
mand bit 0x8 as it wants to control the target position itself. At the same moment, it should stop track-
ing the actual position. Now the drive sets bit 0x1000 and resets bit 0x100 to indicate, it is ready to fol -
low the target positions. If the control system continues to track the actual position at this stage, this
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will cause a chasing behaviour.

8 Registers

Triamec EtherCAT drives support two register ranges. Both ranges are accessed the same way as shown
in Application note AN109. The first set is published to TwinCAT by the COE-Information method. As a
consequence, these are shown in the TwinCAT tab “COE-Online”. These are listed in the table below. A
second range is not shown directly. This large set of registers is usually accessed using the TAM System
Explorer when tuning the axis-motor-drive system. Nevertheless, these registers can be accessed from
TwinCAT using the same function blocks. Finding there addresses is described in AN109. A sample of ac-
cessing a drive register is shown in the NCI TwinCAT sample project. A description of how to setup cyclic
telegrams is explained in AN104.

8.1 Published COE Registers

For axis specific registers use the axis index a={0, 1} in the Index field. For PDO extensions use the ex-
tension index k={0, ..3}. (FW Release 0.8.8)

Index Register

0x1001 errorRegister returns 0x8001 on any error. See 0x603F on per-axis-errors.
0x1008 devicename for example TSD80OE

0x1009 hardwareversion String major.minor

0x100A softwareversion String major.minor.bugfix {-beta means firmware is in beta state}
0x1018 identity 02: productCode

03: HardwareRev ([0..7]=minor, [8..15]=major)
04: SerialNumber

0x1600 + a*0x10 RxPDO mappings for AxisPath
0x1601 + a*0x10
0x1604 + a*0x10

0x1622 + k*0x10 RxPDO extensions See AN104
0x1623 + k*0x10

0x1A00 + a*0x10 TxPDO mappings for AxisPath
0x1A01 + a*0x10
0x1A04 + a*0x10

0x1A22 + k*0x10 TxPDO extensions See AN104
0x1A23 + k*0x10

0x6040 + a*0x800 |The EtherCAT control word
0x6041 + a*0x800 |The EtherCAT status word

0x603F + a*0x800 |The axis error. See table below.

0x6064 + a*0x800 | Position actual
0x606C + a*0x800 | Velocity Actual
0x607A + a*0x800 | Target Position

0x6092 + a*0x800 |FeedConstant 01:Feed, see chapter 6.1
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0x60FF + a*0x800

Target Velocity

A typical content of the TxPdoAssign arrays for two axes and two extensions would be:
RxPdoAssign: 0x1C12 = {4, {0x1601, 0x1611, 0x1623, 0x1633}}
TxPdoAssign: 0x1C13 = {4, {0x1A01, Ox1A11, 0x1A23, 0x1A33}}

Error codes

The axis error 0x603F is also transmitted cyclically. See table below for the error codes. Besides of this
integer representation of an error, it is also possible to see a string representation using the TwinCAT
Event-Logger-Method. An event file and sample code to show the messages is provided in the sample
code TwinCAT project. The TwinCAT event bar executable is at (°).

error |Short form Description

0 None No error

1 PositionErrorLimit The position error limit of the position controller is exceeded.

5 EncoderSubresolutionError The sub-resolution of the encoder is ambiguous. Possible cause:
faulty wiring.

6 EnablingNoMotorAxis Enabling of an Axis with no motor configuration is not possible.

7 EncoderError Encoder works not as expected. (no or too low signal from encoder)

8 EncoderShort The encoder supply is shorted.

9 DigOutputShort A digital output is shorted.

10 Motorl2t The 12t limit of the motor is exceeded.

11 PowerBridgel2tLimit The 12t limit of the power bridge is exceeded.

12 MotorPeakCurrentLimit The peak current limit of the motor is exceeded.

13 PowerBridgePeakCurrentLimit The peak current limit of the power bridge is exceeded.

14 EncoderConfigurationError Two encoders of different type point to the same hardware.

15 OptionModuleFailure An encoder points to an option module which is not present or a
present option module did not boot.

16 EncoderDatabusError Digital Encoder data bus not connected, or communication failed.

17 EncoderNotSupported This encoder type is not supported.

18 NoDigitalEncoderPersistency The encoder does not contain persistency data. Get the reference
and use AN107 to save.

19 PhaseShort A short (phase-to-phase or phase-to-earth) was detected in PWM
during bridge power-up.

20 SynchronizationLost The stream interpolaton synchronization is lost.

21 GantryTrackingError The distance between the two gantry axes was larger than the
GantryDeviationLimit

22 Commutation600HzLimit The 600Hz commutation frequency limit of this product was reached

23 UnspecifiedPositionUnit The position unit is not specified or not known

24 MotorTemperatureLimit The motor temperature is out of specification

5 C:\TwinCAT\3.1\Components\TcEventLogger\TcEventBar.exe.
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25 AxisParameterError A parameter of this axis is unknown

26 AxisCommandeError A command of this axis is unknown

66 ComputingTime The limit of the computing time is exceeded.

69 BridgeVoltageOutOfRange The power bridge voltage is out of range.

70 BridgeOverCurrentLimit The limit of the power bridge current is exceeded.

71 TemperatureLimit The limit of a temperatue is exceeded.

72 VoltageOutOfRange At least one operating voltage is out ouf range.

73 ExternalError The external error is triggered by the user.

74 NoValidTamaCodeAvailable Running Tama without valid Tama code error.

75 InvalidPersistentParameters Persistent parameters are not compatible with running
firmware.

76 TamaOutOfMemory While executing a Tama program, the program memory be-
came full during heap allocation. Memory is typically allo-
cated on the heap when creating new instances of refer-
ence types, including arrays.

77 TamaDivisionByZero While executing a Tama program, an attempt was made to
divide by zero.

78 TamaNullReference While executing a Tama program, an object property was
requested, but there was a null reference.

79 TamalndexOutOfRange While executing a Tama program, an array element index
was outside the range of the array.

80 TamaCorruptedState While executing a Tama program, Tama program state was
corrupted. This value is returned when an unknown opera-
tion code is encountered.

81 MonitorIsNotRunning Hardware monitor on the device is not running.

84 SafeTorqueOffActiveWarning SafeTorqueOff (STO) is active.

85 SafeTorqueOffinconsistent SafeTorqueOff (STO) safe mode due to inconsistent chan-
nels detected (only one contact is closed).

86 SafeTorqueOffStartupTestFailure | SafeTorqueOff (STO) safe mode due to a Startup test failure.

87 SafeTorqueOffPulseTestFailure SafeTorqueOff (STO) safe mode due to a Pulse-Test failure.

88 SafeTorqueOffTemperaturelimit | SafeTorqueOff (STO) safe mode due to Temperature limit on
Logic Monitor.

91 PowerLinesNotOk Power lines are not OK. Not all power lines available or line
disturbance.

92 CommandError A Command was not successful

93 ParameterError Found an unknown or inconsistent Parameter
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8.2

Trouble Shooter

On the TwinCAT side, check

For

C:\TwinCAT\3.1\Config\lo\EtherCAT\Triamec*.xml
TwinCAT/EtherCAT Devices/Reload Device Descriptions
Under 10/Devices/EtherCAT/Drive check "Slots", "Startup", and NC-A etc

general information relevant for the EtherCAT link, see

General/Signals/EtherCAT/LinkPll/State (should be DcMaster or DcSlave)
Axes[0]/Parameters/PositionController/PositionUnit  should be specified
Axes[0]/Commands/PathPlanner/StreamRate

Axes[0]/Signals/General/EtherCAT/

If EtherCAT does not control an axis as expected, check the following

8.3
The

The EtherCAT state of the drive must be OP (Operational).

The Triamec command register Axes[].Commands.General.OverwriteControlSystem must be zero,
which is its default value. A value 1 is used to control the drive using the TAM System Explorer and
disables EtherCAT command requests.

The drive parameter General.Parameters.Standalone must be False. The value True allows using
the drive without a Link and disables EtherCAT command requests and EtherCAT synchronization.
Also, it suppresses the error LinkNotReady.

Make sure, Axes[0]/Parameters/PositionController/MasterPositionSource points to the correct
encoder and Axes[0]/Parameters/PositionController/PositionUnit is correctly set.

Check the following drive signals visible at the EtherCAT interface and in the TAM System Explorer
register:

Axes[]/Signals/General/EtherCAT/ErrorCombined

Axes[]/Signals/General/StateMerged

Axes[]/Signals/General/EtherCAT/ControlWord.

Non standard

hardware revision register 0x1018:03 reserves 8 bits for the minor revision. The CAN standard

specifies 16 bits (EN 50325).

The

register Torque (0x6077) is in absolute Units of mA. CAN does not specify the Unit, but specifies

that the value should be relative to NominalTorque.

Dokument Revision

Version Date Editor Comment
001 16.11.16 mvx  First Release
002 2017-06-16 mvx  Release with Homing

003

2017-11-20 mvx  Reference to AN109, add status and control word content
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Version Date

Editor Comment

004 2018-11-06 dg Chapter Modulo enhanced.

005 2019-02-12 mvx  Explicit Device Identification

006 2019-04-18 mvx  Velocity modes of operation

007 2019-09-23 dg Synchronized with TSD User Guide EP001
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